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100GBASE-KR4 Automated Testing—At a Glance

The Keysight D9010BJBC 100GBASE-KR4 Test Application is an Ethernet test solution that covers 
the electrical timing parameters for 100GBASE-KR4 specification (IEEE 802.3bj D3p2).

The Keysight D9010BJBC 100GBASE-KR4 Test Application:

• Lets you select individual or multiple tests to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Provides detailed information for each test that has been run and lets you specify the thresholds 
at which marginal or critical warnings appear.

• Creates a printable HTML report of the tests that have been run.

NOTE The tests performed by the Keysight D9010BJBC 100GBASE-KR4 Test Application are intended to 
provide a quick check of the electrical health of the DUT. This testing is not a replacement for an 
exhaustive test validation plan.
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Overview 1

Required Equipment and Software

In order to run the 100GBASE-KR4 automated tests, you need the following equipment and 
software:

Hardware

• Use one of the following Oscilloscope models. Refer to www.keysight.com for the respective 
bandwidth ranges.

• Keysight DSA-X / DSO-X 90000 Q-Series Oscilloscopes

• Keysight UXR Oscilloscopes

• For differential probing (minimum 25GHz)

• N2802A 25 GHz InfiniiMax III Series probe amplifier

• N2803A 30 GHz InfiniiMax III Series probe amplifier

• N2836A InfiniiMax III 26 GHz solder-in probe head

• For single-ended probing

• SMA cables that are able to support the 25 Gb speed

• Keyboard, qty = 1, (provided with the Keysight Infiniium oscilloscope)

• Mouse, qty = 1, (provided with the Keysight Infiniium oscilloscope)

• Keysight also recommends using a second monitor to view the test application.

Software

• The minimum version of Infiniium Oscilloscope Software (see the Keysight D9010BJBC 
100GBASE-KR4 Test Application Release Notes)

• Keysight D9010BJBC 100GBASE-KR4 Test Application software

Licensing information

Refer to the Data Sheet pertaining to 100GBASE-KR4 Test Application to know about the licenses 
you must install along with other optional licenses. Visit 
“http://www.keysight.com/find/D9010BJBC” and in the web page's Document Library tab, you may 
view the associated Data Sheet.

To procure a license, you require the Host ID information that is displayed in the Keysight License 
Manager application installed on the same machine where you wish to install the license. 

The licensing format for Keysight License Manager 6 differs from its predecessors. See “Installing the 
License Key" on page 13 to see the difference in installing a license key using either of the 
applications on your machine.

NOTE These can be used as an option, but will be BW limited. Instead, it is 
recommended to test with cables on the Real Edge channels.

http://www.keysight.com/
http://www.keysight.com/find/D9010BJBC
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Installing the Test Application 12
Installing the License Key 13

If you purchased the D9010BJBC 100GBASE-KR4 Test Application separate from your Infiniium 
oscilloscope, you must install the software and license key.
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Installing the Test Application

1 Make sure you have the minimum version of Infiniium Oscilloscope software (see the D9010BJBC 
release notes). To ensure that you have the minimum version, select Help > About Infiniium... from 
the main menu.

2 To obtain the 100GBASE-KR4 Test Application, go to Keysight website: 
“http://www.keysight.com/find/D9010BJBC”.

3 In the web page's Trials & Licenses tab, click the Details and Download button to view instructions 
for downloading and installing the application software.

http://www.keysight.com/find/D9010BJBC
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Installing the Test Application and Licenses 2

Installing the License Key

To procure a license, you require the Host ID information that is displayed in the Keysight License 
Manager application installed on the same machine where you wish to install the license.

Using Keysight License Manager 5

To view and copy the Host ID from Keysight License Manager 5:

1 Launch Keysight License Manager on your machine, where you wish to run the Test Application 
and its features.

2 Copy the Host ID that appears on the top pane of the application. Note that x indicates numeric 
values.

Figure 1 Viewing the Host ID information in Keysight License Manager 5

To install one of the procured licenses using Keysight License Manager 5 application,

1 Save the license files on the machine, where you wish to run the Test Application and its features.

2 Launch Keysight License Manager.

3 From the configuration menu, use one of the options to install each license file.

Figure 2 Configuration menu options to install licenses on Keysight License Manager 5

For more information regarding installation of procured licenses on Keysight License Manager 5, 
refer to Keysight License Manager 5 Supporting Documentation.

https://www.keysight.com/main/redirector.jspx?action=ref&nid=-33002.0.00&lc=eng&cc=IN&ckey=2953922&cname=EDITORIAL&nfr=-33002.0.02
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Using Keysight License Manager 6

To view and copy the Host ID from Keysight License Manager 6:

1 Launch Keysight License Manager 6 on your machine, where you wish to run the Test Application 
and its features.

2 Copy the Host ID, which is the first set of alphanumeric value (as highlighted in Figure 3) that 
appears in the Environment tab of the application. Note that x indicates numeric values.

Figure 3 Viewing the Host ID information in Keysight License Manager 6
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Installing the Test Application and Licenses 2

To install one of the procured licenses using Keysight License Manager 6 application,

1 Save the license files on the machine, where you wish to run the Test Application and its features.

2 Launch Keysight License Manager 6.

3 From the Home tab, use one of the options to install each license file.

Figure 4 Home menu options to install licenses on Keysight License Manager 6

For more information regarding installation of procured licenses on Keysight License Manager 6, 
refer to Keysight License Manager 6 Supporting Documentation.

https://www.keysight.com/main/redirector.jspx?action=obs&nid=-33002.0.00&lc=eng&cc=IN&ckey=2994142&pubno=&ltype=LitStation&ctype=EDITORIAL&nfr=-33002.0.02
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Measurements

Calibrating the Oscilloscope 18
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Configuring 100GBASE-KR4 Test Application for test runs 24
Configuring Switch Matrix 28

Before running the automated tests, you should calibrate the oscilloscope and probe. No test fixture 
is required for this application. After the oscilloscope and probe have been calibrated, you are ready 
to start the 100GBASE-KR4 Test Application and perform the measurements.
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Calibrating the Oscilloscope

If you have not already calibrated the oscilloscope, refer to the User Guide for the respective 
Oscilloscope you are using.

NOTE If the ambient temperature changes more than 5 degrees Celsius from the 
calibration temperature, internal calibration should be performed again. The 
delta between the calibration temperature and the present operating 
temperature is shown in the Utilities > Calibration menu.

NOTE If you switch cables between channels or other Oscilloscopes, it is necessary to 
perform cable and probe calibration again. Keysight recommends that, once 
calibration is performed, you label the cables with the channel on which they 
were calibrated.
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Starting the 100GBASE-KR4 Test Application

1 Ensure that the 100GBASE-KR4 or 25GBASE-KR Device Under Test (DUT) is operating and set to 
desired test modes.

2 To start the 100GBASE-KR4 Test Application: From the Infiniium Oscilloscope's main menu, 
select Analyze > Automated Test Apps > D9010BJBC 100GBASE-KR4 Test App.

• Figure 5 shows the Keysight D9010BJBC 100GBASE-KR4 Test Application window as it appears 
when launched within the Infiniium application of the DSO Q-Series Oscilloscope. The Instrument 
Setup area in the Set Up tab displays Real Edge, which indicates Channels 1R and 3R on the 
oscilloscope.

Figure 5 100GBASE-KR4 Test Application main window on a Z-Series DSO (100GBASE-KR4 option)
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Figure 6 100GBASE-KR4 Test Application main window on a Z-Series DSO (25GBASE-KR option)
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• Figure 7 shows the Keysight D9010BJBC 100GBASE-KR4 Test Application window as it appears 
when launched within the Infiniium application of the UXR Oscilloscope. The Instrument Setup 
area in the Set Up tab displays the corresponding Channel assignments.

Figure 7 100GBASE-KR4 Test Application main window on a UXR Oscilloscope (100GBASE-KR4 option)
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Figure 8 100GBASE-KR4 Test Application main window on a UXR Oscilloscope (25GBASE-KR option)
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The task flow pane and the tabs in the main pane show the steps you take in running the automated 
tests:

Set Up Lets you identify and set up the test environment, including information about the device under 
test.
The Device Identifier, User Description, and Comments are all printed in the final HTML report.
Select the Standard Option and SignalType to be tested.
For UXR scopes, select the appropriate Channel option in Instrument Setup.
Set up InfiniiSim with the InfiniiSim Setup button.
With the Set Channel Skew button, the channels can be visually adjusted and skewed.
The Saved Waveform Setup button enables easy setup of saved waveforms. When waveforms are 
set up, the application makes all measurements on the saved waveforms.
The Select Lane Number enables you to choose to test a single lane or with the switch matrix.

Select Tests Lets you select the tests you want to run. The tests are organized hierarchically so you can select all 
tests in a group. After tests are run, status indicators show which tests have passed, failed, or not 
been run, and there are indicators for the test groups.

Configure Lets you configure test parameters (for example, channels used in test, voltage levels, etc.).

Connect Shows you how to connect the oscilloscope to the device under test for the tests that are to be run.

Run Starts the automated tests. If the connections to the device under test need to be changed while 
multiple tests are running, the tests pause, show you how to change the connection, and wait for 
you to confirm that the connections have been changed before continuing.

Automate Lets you construct scripts of commands that drive execution of the application.

Results Contains more detailed information about the tests that have been run. You can change the 
thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.

NOTE In the Configure tab, the values for all such Configuration parameters that are 
Oscilloscope-dependent, will correspond to the Oscilloscope Model (DSOs or UXRs), where 
you are running the Test Application.
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Configuring 100GBASE-KR4 Test Application for test runs

To run one or more compliance tests on the DUT, which is connected to Oscilloscope, proceed to 
configure the 100GBASE-KR4 Test Application:

1 In the Set Up tab (shown in Figure 5 and Figure 7), select a Multi-Lane Option to determine the lane 
where the tests must be performed for the 100GBASE-KR4 standard.

If Switch Matrix is selected in the Multi-Lane Option, click Switch Matrix Setup to configure the 
Switch Matrix in the Test App. Refer to “Configuring Switch Matrix" on page 28 for more details.

2 In the Select Tests tab, select one or more tests.

3 In the Configure tab, you may change the values assigned to one or more options to cater to the 
compliance requirements for the selected tests. By default, the 100GBASE-KR4 Test Application 
sets optimum values for each configuration parameter.

Figure 9 Configure tab in the 100GBASE-KR4 Test Application

4 In the Connect tab, view the instructions along with the connection digram to ensure that all 
requirements for the physical setup of the testing instruments and the DUT are met. Click 
Connection Completed to indicate to the Test Application that the required hardware setup is 
complete. The connection diagram for most of the tests matches the one shown in Figure 5 for 
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DSO-Q Series Oscilloscopes and Figure 7 for UXR Series Oscilloscopes. However, it is a good 
practice to verify the connection diagram and instructions displayed under this tab. The Test 
Application automatically indicates any changes in connections, if needed, during test runs.

5 Click Run Tests under this tab if you wish to start running tests. However, if you wish to modify the 
run settings before performing test runs, switch to the Run tab.

Figure 10 Connect tab in 100GBASE-KR4 Test Application on a Z-series DSO
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Figure 11 Connect tab in 100GBASE-KR4 Test Application on a UXR scope
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6 In the Run tab, you may optionally modify one or more settings as described below, else click Run 
to start the test runs:

• determine the number of times each test must be run,

• automate specific actions in case of events, 

• store results for certain type of test trials only,

• send email notifications if the test runs pause or stop during runs.

Figure 12 Run tab in 100GBASE-KR4 Test Application

7 In the Automate tab, you may optionally configure automation scripts to perform specific 
actions/sequences within the Test Application.

8 In the Results tab, which appears automatically after test runs are complete, view the test results 
displayed for each selected test.

9 In the HTML Report tab, view a comprehensive report for each test within the Application. The Test 
Application enables exporting these results in CSV or HTML format for the purpose of analysis.

To perform a high-level analysis on each measurement data, you may upload the results to the 
KS6800A Series Analytics Services Software. Refer to “Uploading Results to Repository" on page 80 
to understand an overview on the functionality of this feature.
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Configuring Switch Matrix

Overview

Devices, with 100GBASE-KR4 standard, can run with the switch matrix using four dual single-ended 
connections or without the switch matrix using four differential probe connections. Both options are 
fully automated to switch across the four lanes. Switch Matrix requires either the Keysight U3020A 
S26 or the BitifEye BIT2100.

This chapter describes the switch matrix feature and steps for configuring the switch matrix in the 
Keysight D9010BJBC 100GBASE-KR4 Test Application.

An Oscilloscope has only four Channels to run tests. The limited number of channels may, at times, 
limit the testing of some multi-lane standards. Also, it may prove to be a hindrance to run test 
procedures for multi-port devices or simultaneous testing of multiple devices. The Switch Matrix 
feature on the Infiniium Oscilloscope overcomes such limitations.

The purpose of the ‘Switch Matrix’ feature is to ease the testing procedure, make it more feasible and 
to reduce the overall time. Using this feature, you can connect multiple lanes of the source devices to 
the correct switches and to obtain an accurate signal path whenever required.

Keysight recommends the following switches to be used with the Test Application:

• Keysight U3020A S26

• BitifEye BIT-2100

The following figure shows the connection setup for 100GBASE-KR4 tests with the switch matrix.

Enabling Switch Matrix

Before you begin the testing of multiple lane pairs of the source devices simultaneously, you must 
enable the Switch Matrix feature.

To enable the switch matrix feature:

1 Click Tools>Switch Matrix....

2 In the Configure Switch Matrix Settings dialog box, click On to enable the Switch Matrix feature.
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Enabling the Switch Matrix feature also enables the automated switch control. The option 
Automatically select drivers and paths (limited models) in the Configuration Mode section of the Controller 
tab is selected by default.

Establishing Connection to the Switch Drivers

Establishing connection to the Switch Drivers — Automatically

In the Configure Switch Matrix Settings dialog, under the Controller tab:

1 From the Switch Drivers section, select the switch model from the Model: drop-down options.

NOTE The switch settings and the response correction for all paths are reset if you 
toggle between switch models.
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2 Click the Connect button to be able to connect the selected switch driver to a physical switch 
instrument.

3 A Connect to <switch-model> dialog appears, which gives you two options to establish a 
connection to the selected switch models.

4 Select one of the options to establish connection:

Selecting Enter/Select VISA address/alias
1 Select Enter/Select VISA address/alias to type the complete SICL or VISA address of the switch 

driver. By default, this option is selected.

2 Click the Get button to identify the instrument at the specified address or alias and to view the 
current status of the instrument that is connected to the switch driver.

3 Click OK to return to the Configure Switch Matrix Settings dialog. The connection to the selected 
switch is displayed.
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4 Click OK to save the settings and return to the test environment.

Selecting from Keysight Connection Expert favorites
1 Choose Select from Keysight Connection Expert favorites to control the application with the help of 

remote PC. Upon selecting this option, the application starts seeking device information from the 
Keysight Connection Expert.

If remote access of the device is enabled, the Connect to <switch-model> dialog displays the list 
of active instruments.
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2 Click to select the Identify / Hide unresponsive addresses check box to run an IDN query to every 
instrument in the list and search for the active instruments, if any.

3 If any active instruments are found, the Connect to <switch-model> dialog lists out such 
instruments. Select the required instrument from the list.

4 Click OK to return to the Configure Switch Matrix Settings dialog. The connection to the selected 
switch is displayed.

5 Click OK in the Configure Switch Matrix Settings dialog to save the settings and return to the test 
environment.
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Establishing connection to the Switch Drivers — Manually

The Manually perform these tasks (any supported model) option allows you to decide how many drivers to 
use and how to route the signal paths. It enables the use of any supported switch model.

In the Configure Switch Matrix Settings dialog:

1 Click to select the Manually perform these tasks (any supported model) radio button in the Configuration 
Mode section.

2 From the Switch Drivers section, select the switch model from the Model: drop-down options.

3 In the Switch Drivers section, you may use the Add button to append the list of any additional 
drivers, which require a connection to an instrument. Use the Delete button to remove a selected 
driver from the list. Removing the driver from the list dissociates any signal paths that may have 
been assigned to it earlier.

NOTE The Select from Keysight Connection Expert favorites option is available 
only when the device is powered on and enabled for remote access. 
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4 When you click the Add... button, the Connect... button appears so that you can establish 
connectivity to the selected Switch. 

5 The rest of the steps for establishing a connection to the switch model remains the same as 
described in the previous section. The only difference between automatic and manual modes is 
that you can add/delete and select switch drivers (any supported model) as per your 
requirements and preferences in the manual mode.

Configuring Signal Paths

Once you have enabled the Switch Matrix feature and set up connections to the switch drivers, you 
must configure signal paths. The options to configure the signal paths vary depending upon whether 
you have selected Automatically select drivers and paths (limited models) or Manually perform these tasks 
(any supported model) in the Controller tab of the Configure Switch Matrix Settings dialog.

Refer to the connection diagram before configuring signal paths either for Automatic or Manual 
selection. Under the Controller tab, click the Connection Guide button to access the Connection 
Diagram dialog.
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Configuring Signal Paths with Automatic Selection

When you have selected Automatically select drivers and paths (limited models) in the Controller tab of the 
Configure Switch Matrix Settings dialog:

1 Click the Signal Paths tab. The Path Assignment table lists the connection matrix of the device with 
the Switch modules.

2 Scroll down to view the automatic connections that have been established.

At runtime, when the Switch Matrix module is on and when a connection prompt occurs, two events 
occur:

• The framework suppresses the prompts.

• The Switch Matrix module detects the new connection and then throw switches, as indicated in 
the Switch column, taking into account the current value of the configuration variable (if any) 
associated with the connection.

Configuring Signal Paths with Manual Selection

When you have selected Manually perform these tasks (any supported model) in the Controller tab of the 
Configure Switch Matrix Settings dialog:

1 Click the Signal Paths tab in the Configure Switch Matrix Settings dialog.

2 Select the channel or switch module in one of the drop-down options. Manually select the 
alternative channel or driver module from the other drop-down option.

3 Optionally, you may change the lane assignments and the corresponding Switch modules.

4 Click the View Connections... button to view the signal path mapping, to understand how the 
signal path maps to the connection diagrams being used by the application.

5 The Signal Paths Connection View dialog is displayed. Select any one of the available options in the 
Connection: drop-down.

6 The Path Assignment & Response Correction area displays the connections configured for the 
corresponding connection diagrams in the Connection: drop-down.

7 Select an entry in the Path Assignment & Response Correction area to view the corresponding test 
information.

8 Click the Tests... button to view information about the tests that use the selected connection to 
perform automated tests.

9 Click the Close button to exit and return to the Configure Switch Matrix Settings dialog to finish the 
signal path configuration.

10 If required, use the Reset Paths... button to clear all switch and response correction settings for all 
paths. Click OK if you wish to proceed.

11 Also, if needed, use the Load Preconfigured Settings... button to set switches for all paths as per the 
recommended settings. Click OK if you wish to proceed.
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Preparing to Take Measurements 3

Response Correction

You must specify the response correction after you finish configuring the signal paths. Configuring 
this area is vital as it impacts the measurement accuracy, credibility and performance of the 
Oscilloscope. The purpose of response correction is to correct the channel frequency response of the 
oscilloscope.

For each scope channel that you select, the default response correction method is None, which turns 
off normalization for the specified path. 

You may use the Edit Settings button or double-click the selected row to access the corresponding 
configuration dialog, if you wish to make further changes to a specific scope channel configuration.

Use the Execute Switches button to establish a connection between the selected test point and scope 
channel. The color of this button corresponds to the Oscilloscope Channel where the Switch is 
connected to.

In the following example, the application displays the prompt indicating that a connection is 
established when you click Execute Switches after selecting the first row. Click OK to close the prompt.
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Once you have finished response corrections for all connections, click OK in the Configure Switch Matrix 
Settings dialog. The application redirects you to the test environment.
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4 Main Voltage Measurements

Differential Peak to Peak Output Voltage Test with TX Disabled 41
DC Common Mode Output Voltage Test 42
AC Common Mode Output Voltage Test 43
Differential Peak to Peak Output Voltage Test 44

This section provides the Methods of Implementation (MOIs) for the Main Voltage Measurements 
using a Keysight Infiniium oscilloscope and the 100GBASE-KR4 Test Application.
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Figure 13 Tests under Main Voltage Measurements

Limits for Main
Voltage

Measurements

The limits for tests under main voltage measurements can be found in section 93.8.1.3 of IEEE 802.3 
specifications. Refer to Table 93-4 for corresponding values.

• Differential Peak to Peak Output Voltage with TX disabled (max 30 mV).

• DC Common Mode Output Voltage (0-1.9 V).

• AC Common Mode Output Voltage (max 12 mV).

• Differential Peak to Peak Output Voltage (max 1200 mV).
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Main Voltage Measurements 4

Differential Peak to Peak Output Voltage Test with TX Disabled

The purpose of this test is to verify that when TX is disabled the peak-to-peak voltage is less than 
30 mV.

PASS Condition The max peak-to-peak voltage is less than 30 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is truly with TX disabled (no valid data transitions).

3 Measure peak-to-peak voltage of the signal.

4 Compare the max peak-to-peak voltage to 30 mV.
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DC Common Mode Output Voltage Test

The purpose of this test is to verify that the common mode signal of the differential pair is between 
0-1.9 V.

PASS Condition The signal is between 0-1.9 V.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the Vmax and Vmin and get the worst result.

• If the Test Application is running on the DSO Oscilloscope, the Instrument Setup is preset to 
Real Edge.

• If the Test Application is running on the UXR Oscilloscope, perform the measurement with the 
Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument 
Setup set to Channels 3 and 4.

4 Compare the voltage measurement to 0-1.9 V.

NOTE This measurement can be done only with dual-single ended connection; it cannot be done with a 
differential probing connection.
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Main Voltage Measurements 4

AC Common Mode Output Voltage Test

The purpose of this test is to verify that the common mode signal of the differential pair rms voltage 
does not exceed 12 mV.

PASS Condition The signal is less than 12 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the Vrms of the addition of channel 1 and 3 or channel 2 and 4.

4 Compare the voltage measurement to 12 mV.

NOTE This measurement can be done only with dual-single ended connection; it cannot be done with a 
differential probing connection.
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Differential Peak to Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential signal on a 
PRBS9 pattern is less than 1200 mV.

PASS Condition The differential signal max peak to peak voltage on a PRBS9 pattern is less than 1200 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected and has a PRBS9 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

4 Compare the max peak-to-peak voltage to 1200 mV.
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5 Jitter and Signaling Rate 
Measurements

Signaling Rate 47
Jitter (Even-Odd Jitter, Bounded Uncorrelated Jitter, Total Uncorrelated Jitter) 48

This section provides the Methods of Implementation (MOIs) for the Jitter and Signaling Rate 
Measurements using a Keysight Infiniium oscilloscope and the 100GBASE-KR4 Test Application.
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Figure 14 Tests under Jitter and Signaling Rate Measurements

Limits for Jitter and
Signaling Rate
Measurements

The limits for tests under jitter and signaling rate measurements can be found in various sections of 
IEEE 802.3 specification. Refer to Table 93-4 for corresponding values.

• Signaling Rate (25.78125 ±100 ppm GBd) (section 93.8.1.2)

• Even-Odd Jitter (max 35 mUI) (section 93.8.1.7)

• Bounded Uncorrelated Jitter (max 100 mUI) (section 93.8.1.7)

• Total Uncorrelated Jitter (max 180 mUI) (section 93.8.1.7)



Keysight D9010BJBC 100GBASE-KR4 Test Application Methods of Implementation 47

Jitter and Signaling Rate Measurements 5

Signaling Rate

The purpose of this test is to verify that the signaling rate mean is between 25.78125 ±100 ppm GBd.

PASS Condition The mean signaling rate is between 25.78125 ±100 ppm GBd.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS9 must be used for this test).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Set data rate measurement to semi-automatic 25.78125 Gb/s.

5 Measure min, max, mean data rate.

6 Report min and max values.

7 Compare and report the mean data rate value to 25.78125 ±100 ppm GBd.
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Jitter (Even-Odd Jitter, Bounded Uncorrelated Jitter, Total Uncorrelated Jitter)

The purpose of this test is to verify that differential signal's Even-Odd Jitter is less that 35 mUI, 
Bounded Uncorrelated Jitter is less than 100 mUI, and Total Uncorrelated Jitter is less than 180 mUI. 
If all tests are selected, all tests are run on a single measurement. Each test can be run individually 
by selecting any or some of the tests.

PASS Conditions • Even-Odd Jitter is less than 35 mUI.

• BUJ is less than 100 mUI.

• Total Uncorrelated Jitter rms is less than 180 mUI.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS9 must be used for this test).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Set clock recovery to OJTF First Order PLL with Nominal Data Rate 25.78125 Gb/s and Loop 
Bandwidth to 10 MHz.

5 Using EZJIT, measure Even-Odd Jitter, BUJ, and TUJ at BER of 10E-12.

6 Compare and report the values to their respective maximum specification.
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6 Output Waveform 
Measurements

Steady State Voltage Vf 51
Linear Fit Pulse Peak 52

This section provides the Methods of Implementation (MOIs) for the Transmitter Output Waveform 
Measurements using a Keysight Infiniium oscilloscope and the 100GBASE-KR4 Test Application.
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Figure 15 Tests under Output Waveform Measurements

Limits for Output
Waveform

Measurements

The limits for some tests under output waveform measurements can be found in various sections of 
IEEE 802.3 specification. Refer to Table 93-4 for corresponding values.

• Steady State Voltage Vf (400-600 mV) (section 93.8.1.5.2)

• Linear Fit Pulse Peak (0.71 * Vf) (section 93.8.1.5.2)

• Signal-to-noise-and-distortion ratio (27 dB) (section 93.8.1.6)
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Output Waveform Measurements 6

Steady State Voltage Vf

The purpose of this test is to verify that the Steady State Voltage as described in section 85.8.3.3 is 
between 0.4 and 0.6 V.

PASS Condition The Steady State Voltage is between 0.4 and 0.6 V.

Measurement
Algorithm

1 Set memory depth to capture one full PRBS9 pattern and scale.

2 Calculate Vf using the equations in section 92.8.3.7. The result value is the sum of the columns in 
P1 (Equ 92-9).

3 Compare and report the result to 0.4-0.6 V.
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Linear Fit Pulse Peak

The purpose of this test is to verify that the Linear Fit Pulse as described in section 85.8.3.3 is greater 
than the Vf * 0.71 for 100GBASE-KR4 and 0.75*Vf for 25GBASE-KR.

PASS Condition The Linear Fit Pulse is greater than Vf * 0.71 for 100GBASE-KR4 and Vf * 0.75 for 25GBASE-KR 
standard.

Measurement
Algorithm

1 Set memory depth to capture one full PRBS9 pattern and scale.

2 Calculate p(k) linear fit using the equations in section 85.8.3.3.5. The result value is the max of 
p(k).

3 Compare and report the result to 0.71*Vf for 100GBASE-KR4 and 0.75*Vf for 25GBASE-KR.
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Output Waveform Measurements 6

Signal-to-noise-and-distortion ratio

The purpose of this test is to verify that the Signal-to-noise-and-distortion ratio (SNDR) is greater 
than 27dB.

PASS Condition The SNDR must be greater than 27dB.

Measurement
Algorithm

1 Calculate SNDR using measurements from Level RMS - PRBS pattern test and error from Linear 
Fit Pulse Peak test.

2 Compare and report the value of SNDR with 27dB.
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7 Normalized Coefficient Step 
Size Measurements

abs Coefficient Step Size c(1) inc c(0)hold c(-1)hold 57
abs Coefficient Step Size c(1)dec c(0)hold c(-1)hold 58
abs Coefficient Step Size c(1)hold c(0)inc c(-1)hold 59
abs Coefficient Step Size c(1)hold c(0)dec c(-1)hold 60
abs Coefficient Step Size c(1)hold c(0)hold c(-1)inc 61
abs Coefficient Step Size c(1)hold c(0)hold c(-1)dec 62

This section provides the Methods of Implementation (MOIs) for the Transmitter Output Waveform 
Normalized Coefficient Step Size Measurements using a Keysight Infiniium oscilloscope and the 
100GBASE-KR4 Test Application.
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Figure 16 Tests under Normalized Coefficient Step Size Measurements

Limits for Normalized
Coefficient Step Size

Measurements

The limits for tests under normalized coefficient step size measurements can be found in various 
sections of IEEE 802.3 specification. Refer to Table 93-4 for corresponding values.

• abs coefficient step size (min. 0.0083) (section 93.8.1.5.4)

• abs coefficient step size (max. 0.05) (section 93.8.1.5.4)
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Normalized Coefficient Step Size Measurements 7

abs Coefficient Step Size c(1) inc c(0)hold c(-1)hold

The purpose of this test is to verify that the difference amplitude between coefficient updates falls 
between the specified values 0.0083 and 0.05.

PASS Condition The difference in the coefficient update when c(1) is incremented to the previous is within 0.0083 to 
0.05.

Measurement
Algorithm

1 Request transmitter to be set to 'PRESET' condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at 'PRESET' condition.

4 Define matrix Rm using Equation (92-4) from IEEE802.3.

5 Request to change the Tx setting to a Baseline condition that allows for increment.

6 Calculate the coefficients defined in (92-5).

7 Request to change the Tx setting to increment.

8 Calculate linear fit pulse response.

9 Calculate coefficients of new waveform with equation (92-5).

10 Compare result to previous setting.

11 Loop steps 7 – 10 for as many increments to be tested.

12 Compare and report the values and verify they are in the range of 0.0083 to 0.05.
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abs Coefficient Step Size c(1)dec c(0)hold c(-1)hold

The purpose of this test is to verify that the difference in amplitude between the coefficient updates, 
falls between the specified values of -0.0083 to -0.05.

PASS Condition The difference in the coefficient update when c(1) is decremented to the previous is within -0.0083 to 
-0.05.

Measurement
Algorithm

1 Request transmitter to be set to 'PRESET' condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at 'PRESET' condition.

4 Define matrix Rm using Equation (92-4) from IEEE802.3.

5 Request to change the Tx setting to a Baseline condition that allows for decrement.

6 Calculate the coefficients defined in (92-5).

7 Request to change the Tx setting to decrement.

8 Calculate linear fit pulse response.

9 Calculate coefficients of new waveform with equation (92-5).

10 Compare result to previous setting.

11 Loop steps 7 – 10 for as many decrements to be tested.

12 Compare and report the values and verify they are in the range of -0.05 to -0.0083 for dec.
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Normalized Coefficient Step Size Measurements 7

abs Coefficient Step Size c(1)hold c(0)inc c(-1)hold

The purpose of this test is to verify that the difference in amplitude between the coefficient updates 
falls between the specified values of 0.0083 to 0.05.

PASS Condition The difference in the coefficient update when c(0) is incremented to the previous state is within 
0.0083 to 0.05.

Measurement
Algorithm

1 Request transmitter to be set to 'PRESET' condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at 'PRESET' condition.

4 Define matrix Rm using Equation (92-4) from IEEE802.3.

5 Request to change the Tx setting to a Baseline condition that allows for increment.

6 Calculate the coefficients defined in (92-5).

7 Request to change the Tx setting to increment.

8 Calculate linear fit pulse response.

9 Calculate coefficients of new waveform with equation (92-5).

10 Compare result to previous setting.

11 Loop steps 7 – 10 for as many increments to be tested.

12 Compare and report the values and verify they are in the range of 0.0083 to 0.05.
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abs Coefficient Step Size c(1)hold c(0)dec c(-1)hold

The purpose of this test is to verify that the difference in amplitude between the coefficient updates 
falls between the specified values of -0.0083 to -0.05.

PASS Condition The difference in the coefficient update when c(0) is decremented to the previous state is within 
-0.0083 and -0.05.

Measurement
Algorithm

1 Request transmitter to be set to 'PRESET' condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at 'PRESET' condition.

4 Define matrix Rm using Equation (92-4) from IEEE802.3.

5 Request to change the Tx setting to a Baseline condition that allows for decrement.

6 Calculate the coefficients defined in (92-5).

7 Request to change the Tx setting to decrement.

8 Calculate linear fit pulse response.

9 Calculate coefficients of new waveform with equation (92-5).

10 Compare result to previous setting.

11 Loop steps 7 – 10 for as many decrements to be tested.

12 Compare and report the values and verify they are in the range of -0.05 to -0.0083 for dec.
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Normalized Coefficient Step Size Measurements 7

abs Coefficient Step Size c(1)hold c(0)hold c(-1)inc

The purpose of this test is to verify that the difference in amplitude between the coefficient updates 
falls between the specified values of 0.0083 to 0.05.

PASS Condition The difference in the coefficient update when c(-1) is incremented to the previous state is within 
0.0083 and 0.05.

Measurement
Algorithm

1 Request transmitter to be set to 'PRESET' condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at 'PRESET' condition.

4 Define matrix Rm using Equation (92-4) from IEEE802.3.

5 Request to change the Tx setting to a Baseline condition that allows for increment.

6 Calculate the coefficients defined in (92-5).

7 Request to change the Tx setting to increment.

8 Calculate linear fit pulse response.

9 Calculate coefficients of new waveform with equation (92-5).

10 Compare result to previous setting.

11 Loop steps 7 – 10 for as many increments to be tested.

12 Compare and report the values and verify they are in the range of 0.0083 to 0.05.
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abs Coefficient Step Size c(1)hold c(0)hold c(-1)dec

The purpose of this test is to verify that the difference in amplitude between the coefficient updates 
falls between the specified values of -0.0083 to -0.05.

PASS Condition The difference in the coefficient update when c(-1) is decremented to the previous state is within 
-0.0083 and -0.05.

Measurement
Algorithm

1 Request transmitter to be set to 'PRESET' condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at 'PRESET' condition.

4 Define matrix Rm using Equation (92-4) from IEEE802.3.

5 Request to change the Tx setting to a Baseline condition that allows for decrement.

6 Calculate the coefficients defined in (92-5).

7 Request to change the Tx setting to decrement.

8 Calculate linear fit pulse response.

9 Calculate coefficients of new waveform with equation (92-5).

10 Compare result to previous setting.

11 Loop steps 7 – 10 for as many decrements to be tested.

12 Compare and report the values and verify they are in the range of -0.05 to -0.0083 for dec.
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8 Full Scale Range Tests

Minimum Pre-cursor Full-scale Test 65
Minimum Post-cursor Full-scale Test 66

This section provides the Methods of Implementation (MOIs) for the Transmitter Output Waveform 
Full-Scale Range Measurements using a Keysight Infiniium oscilloscope and the 100GBASE-KR4 
Test Application.
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Figure 17 Tests under Full-Scale Range Measurements

Limits for Full Scale
Range Tests

The limits for tests under full scale range tests can be found in various sections of IEEE 802.3 
specification. Refer to Table 93-4 for corresponding values.

• minimum Pre-cursor Full-scale Range (1.54) (section 93.8.1.5.5)

• minimum Post-cursor Full-scale Range (4) (section 93.8.1.5.5)
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Full Scale Range Tests 8

Minimum Pre-cursor Full-scale Test

The purpose of this test is to verify that the minimum Pre-cursor is greater than or equal 1.54.

PASS Condition When the coefficients are set to c(1) zero c(0) minimum and c(-1) minimum, the pre-cursor full-scale 
ratio is greater than or equal 1.54.

Measurement
Algorithm

1 Request transmitter to be set to 'PRESET' condition (only if not previously have 'PRESET' 
measurement on same trial from step size).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at 'PRESET' condition (if not previously done in same trial on 
step size).

4 Define matrix Rm using Equation (92-4) from IEEE 802.3 (if not previously done in same trial on 
step size).

5 Request to change the Tx setting to c(-1) zero and c(0) and c(1) to their minimum values.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate precursor ratio (c(0) – c(-1))/(c(0) + c(-1)).

9 Report and compare the value calculated in step 8 with 1.54.



8 Full Scale Range Tests

66 Keysight D9010BJBC 100GBASE-KR4 Test Application Methods of Implementation

Minimum Post-cursor Full-scale Test

The purpose of this test is to verify that the minimum Post-cursor is greater than or equal to 4.

PASS Condition When the coefficients are set to c(1) minimum c(0) minimum and c(-1) zero, the post-cursor 
full-scale ration is greater than or equal to 4.

Measurement
Algorithm

1 Request transmitter to be set to 'PRESET' condition (only if not previously have 'PRESET' 
measurement on same trial from step size).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at 'PRESET' condition (if not previously done in same trial on 
step size).

4 Define matrix Rm using Equation (92-4) from IEEE 802.3 (if not previously done in same trial on 
step size).

5 Request to change the Tx setting to c(1) zero and c(0) and c(-1) to their minimum values.

6 Calculate linear fit pulse response.

7 Calculate coefficients with equation (92-5).

8 Calculate postcursor ratio (c(0) – c(1))/(c(0) + c(1)).

9 Report and compare the value calculated in the previous step with 4.
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9 Return Loss PNA/ENA 
Measurements

This section provides the Methods of Implementation (MOIs) for the Return Loss Measurements 
using a Keysight Infiniium oscilloscope, PNA or ENA, and the 100GBASE-KR4 Test Application. The 
test application controls the PNA/ENA to set the test limits and run the test. You must ensure that 
the calibration must be done on the PNA/ENA. 

NOTE To prevent blank graphs / empty measurement screen-shots being displayed 
after test run in the HTML Report, it is recommended to use VNC for remotely 
controlling the PNA/ENA.

PNA - Performance Network Analyzer

ENA - Economy Network Analyzer
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Figure 18 Tests under Return Loss Measurements

Limits for Return Loss
PNA/ENA

Measurements

The limits for tests under return loss PNA/ENA measurements can be found in various sections of 
IEEE 802.3 specification. Refer to Table 93-4 for corresponding values.

• Differential Output Return Loss (refer to section 93.8.1.4 and see Eq. 93-3)

• Common-mode Output Return Loss (refer to section 93.8.1.4 and see Eq. 93-4)

Measurement
Algorithm (common

for both tests)

1 Ensure that the PNA/ENA is physically connected and calibrated.

2 In the Set Up tab of the Test Application, click Connect PNA or Connect ENA to establish connectivity 
to the connected equipment.

3 Click the Select Tests tab and check the tests to measure the Return Loss Measurements.

4 Click Run under the Run tab. The Test Application automatically calculates the return loss.

5 Compare the reported values with the specification to check for compliance.
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10 DME/EEE Waveform 
Measurements

DME Differential Peak-to-Peak Output Voltage Test 71
DME T1-Transition Position Spacing (Period) Test 72
DME T2-Clock Transition to Clock Transition Test 73
DME T3-Clock Transition to Data Transition Test 74
EEE Differential Peak-to-Peak Output Voltage Test with TX Disabled 75
EEE Differential Peak-to-Peak Output Voltage Test 76
EEE Common Mode Deviation Voltage Test 77

This section provides the Methods of Implementation (MOIs) for the DME and EEE Waveform 
Measurements using a Keysight Infiniium oscilloscope and the 100GBASE-KR4 Test Application.
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Figure 19 Tests under DME and EEE Waveform Measurements

Limits for DME/EEE
Waveform

Measurements

The limits for tests under DME/EEE Waveform measurements can be found in various sections of 
IEEE 802.3 specification. The 100GBASE-KR4 DME specifications can be found in IEEE 802.3ap-2012 
section 73.5.1 Table 73-1 and section 73.5.3 Table 73-2. The 100GBASE-KR4 EEE specifications can 
be found in section 72.7.1 Table 72-6.

• DME Differential Peak-to-Peak Output Voltage (0.6-1.2 V).

• DME T1 (3.2 ns-0.01% to 3.2 ns+0.1%).

• DME T2 (6.2 ns-6.6 ns).

• DME T3 (3.0 ns-3.4 ns).

• EEE Differential Peak-to-Peak Output Voltage with TX disabled (max 30 mV).

• EEE Differential Peak-to-Peak Output Voltage with TX enabled (min 720 mV).

• EEE Common Mode Voltage Deviation (±150 mV).
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DME/EEE Waveform Measurements 10

DME Differential Peak-to-Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential signal on a 1010 
pattern is less than 1200 mV.

PASS Condition The differential signal max peak-to-peak voltage on a 1010 pattern is less than 1200 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected and has a 1010 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

4 Compare the min and max peak-to-peak voltage to be within 0.6 to 1.2 V.
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DME T1-Transition Position Spacing (Period) Test

The purpose of this test is to verify that transition spacing of the DME signal is 3.2 ns ±0.01%.

PASS Condition The mean period is between 3.2 ns ±0.01%.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected.

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Request DUT in DME mode.

5 Measure the unit interval of the differential DME signal – set UI measurement to SEMI, 3.2e-9.

6 Compare the mean measurement to 3.2 ns ±0.01%.
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DME/EEE Waveform Measurements 10

DME T2-Clock Transition to Clock Transition Test

The purpose of this test is to verify clock to clock transition is 6.2 ns to 6.6 ns.

PASS Condition The mean period is between 6.2 ns to 6.6 ns.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected.

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Request DUT in DME mode.

5 Measure the rising to rising edge.

6 Compare the min and max values to measurement to 6.2 ns to 6.6 ns.
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DME T3-Clock Transition to Data Transition Test

The purpose of this test is to verify clock to data transition is 3.0 ns to 3.4 ns.

PASS Condition The min and max UI time is between 3.0 ns to 3.4 ns.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected.

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Request DUT in DME mode.

5 Measure the unit interval of the differential DME signal – set UI measurement to SEMI, 3.2e-9.

6 Compare the min and max values to measurement to 3.0 ns to 3.4 ns.
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DME/EEE Waveform Measurements 10

EEE Differential Peak-to-Peak Output Voltage Test with TX Disabled

The purpose of this test is to verify that when TX is disabled the peak-to-peak voltage is less than 
30 mV.

PASS Condition The max peak-to-peak voltage is less than 30 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Request DUT to be EEE mode.

3 Check that the signal is truly with TX disabled (no valid data transitions).

4 Measure peak-to-peak voltage of the signal.

5 Compare the max peak-to-peak voltage to 30 mV.
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EEE Differential Peak-to-Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential signal on a 1010 
pattern is greater or equal to 720 mV.

PASS Condition The differential signal max peak-to-peak voltage on a 1010 pattern is greater than or equal to 
720 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Request DUT in EEE mode.

3 Verify that there is a signal is connected and has a 1010 pattern.

4 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

5 Compare the min voltage to be greater than or equal to 720 mV.
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DME/EEE Waveform Measurements 10

EEE Common Mode Deviation Voltage Test

The purpose of this test is to verify that the common mode signal of the differential pair of the pre-LPI 
signal and the LPI signal is within ±150 mV.

PASS Condition The signal voltage change between pre and post LPI is within 150 mV change.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Request DUT to be pre-LPI.

4 Measure the peak-to-peak voltage.

• If the Test Application is running on the DSO Oscilloscope, the Instrument Setup is preset to Real 
Edge.

• If the Test Application is running on the UXR Oscilloscope, perform the measurement with the 
Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set to 
Channels 3 and 4.

5 Request DUT to be in LPI.

6 Measure the peak-to-peak voltage again.

• If the Test Application is running on the DSO Oscilloscope, the Instrument Setup is preset to Real 
Edge.

• If the Test Application is running on the UXR Oscilloscope, perform the measurement with the 
Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set to 
Channels 3 and 4.

7 Calculate Vpp(post)-Vpp(pre).

8 Compare the result from step 8 to ±150 mV.
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Uploading Results to Repository

The Upload Results To Repository feature is an add-on to the Keysight Test Application, where it 
expands the boundaries of storing and analyzing the measurement results to a wider audience, who 
may be based in multiple sites across various geographical locations. Along with the feature of 
exporting test results from the Test Application into your local disk in a CSV or HTML file format, you 
have the option to upload the test results to a Dataset on a Web Repository. Based on your 
requirements, you may either upload only a single measurement trial or upload huge volumes of 
measurement results to any Dataset.

Not only can remote users with an active Internet connection access these Datasets and the 
corresponding test results on the Web Repository, but they have the option to add and delete 
Datasets on the Web Server. In the Upload Results To Repository feature, you can even modify the 
Dataset properties, which are helpful especially when performing a graphical analysis of the 
uploaded data.

In combination with the Keysight KS6800A Series Analytics Software, the Upload Results To 
Repository feature provides a comprehensive solution to export, view and perform analysis of the 
measurement results, thereby resulting in qualitative data to ensure that the Device Under Test 
(DUT) is compliant to the industry standards.

Refer to the Keysight KS6800A Series Analytics Software Online Help for more information about the 
functionality of various features in this software.

To export measurement results to the Repository after the completion of test runs,

1 From the Test Application’s main menu, click File > Export Results... > Repository.
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Exporting Measurement Results to Repository 11

The Upload Results to Repository window appears.

2 In the Connect to Server pane of the Datasets tab, click Connect... to login to the Dataset Repository 
server.

3 In the URL: drop-down text field that appears, replace the default text with the actual IP address 
or the URL along with the port number, if applicable.

You may enter the URL of the Web Repository server, which may be a self-hosted server on your 
machine (http://localhost:5000/), a remote server or an authentication server. Note that all such 
URLs accessed via this window appear as a drop-down list in the URL: field.

4 Click the Check button to verify that the KS6800A Series Analytics service is available on the 
specified web address. Repeat this step each time you edit the web address.
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• For unrestricted access to the Repository

a If the server does not require authentication and the KS6800A Series Analytics service is found 
on the specified web address, the version information is displayed adjacent to the Check 
button.

b If you click OK, the Upload Results to Repository window displays the connectivity status to 
the Dataset Repository.

c Click Browse... to navigate directly to the URL.

• For restricted access to the Repository

a If service is found on the specified URL but access to the web server is restricted based on 
authentication, the version information is displayed along with the text Authentication 
Required adjacent to the Check button. Also, the Username: and Password: fields appear. The 
OK button remains disabled until the authentication credentials are entered.

b Enter the user credentials in the respective fields, which are required for authentication to 
access those Datasets that have been created on the web server you are connecting to. For 
each URL that you access, the Username: drop-down box keeps a record and displays all user 
names used to access the respective URL.
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Exporting Measurement Results to Repository 11

c Click OK to connect to the entered URL/IP address.

The Connect to Server area displays the connection status along with the username.

d Click Browse... to navigate directly to the URL.

5 In the Select Dataset area, click Select... to view the list of Datasets created on the connected 
repository. Click Refresh to update the list of Datasets that appear in the Test Application's user 
interface.

6 Select the Dataset name where you wish to upload measurement results to. Click OK.
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The Select Dataset area displays the selected Dataset as Active. The Measurements and 
Properties tabs are enabled after a Dataset is selected.
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Exporting Measurement Results to Repository 11

7 Click the Measurements tab where the test results from the last test run are displayed.

8 You may select and export multiple test results to the repository. You may change the format for 
the display of measurement data using the drop-down options in the Group by: field.

9 After selecting one or more measurements, either click Upload or switch to the Properties tab to 
associate one or more properties to the measurements that are being uploaded to the Web 
Server.
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To perform an enhanced analysis on the measurement data using the KS6800A Series Analytics 
Service Software, Keysight recommends assigning properties to the measurements.
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Exporting Measurement Results to Repository 11

10 Click the Properties tab to assign properties for your measurement results that you select to 
upload. By default, the App-Defined properties are selected to be uploaded in association with the 
measurement data, wherein only certain aspects of the selected measurements are uploaded. 
However, you may switch to Globals to include as properties one or more options configured 
under the rest of the tabs of the Compliance Test Application or define one or more custom 
property values to be associated with the selected measurement data.

11 Click Upload to begin uploading measurement results.

12 Click Close to exit the Upload Results to Repository window and to return to the Compliance Test 
Application.

You may access the Dataset Repository using the Internet browser on your machine to view the 
measurement results graphically on the KS6800A Series Analytics Service Software.
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KS6800A Series Analytics Service Software

The KS6800A Series Analytics Service software supports multiple data sources and also a wide range 
of data import clients. This web-based software provides various types of charts, such as Histogram, 
Box-and-Whisker, Line, Scatter, Eye Diagram and Constellation, each with split capability to enable 
data analysis. Once you upload the measurement results to a Dataset on the KS6800A Series 
Analytics Service Software via the Upload Results to Repository window of the Test Application, the 
measurement results can be viewed graphically as shown below:

For more information on the Data Analytics Web Service Software, visit KS6800A Series Analytics 
Service Software page on the Keysight website. You may refer to the Help manual provided within 
the software to understand the functionality of its features.

https://www.keysight.com/en/pd-2976519-pn-KS6800A/data-analytics-software?nid=-32976.1259666&cc=US&lc=eng
http://www.keysight.com/en/pd-2747984-pn-N8844A/data-analytics-web-service-software?cc=US&lc=eng
https://www.keysight.com/en/pd-2976519-pn-KS6800A/data-analytics-software?nid=-32976.1259666&cc=US&lc=eng
https://www.keysight.com/en/pd-2976519-pn-KS6800A/data-analytics-software?nid=-32976.1259666&cc=US&lc=eng
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12 Debug Mode

Debug mode can be selected to make enable the ability to change jitter measurement options. In the 
Configuration tab, select the Debug radio button. This will add the following options:

• Rj Bandwidth — Choose the Rj Filter. Options are Narrow (Pink) or Wide (White). This changes the 
amount of DC jitter in the Rj measurement.

• Jitter Pattern Length — Choose Periodic or Arbitrary. Periodic is used for data patterns that are 
periodic and repeat through the scope memory. Arbitrary is used for random data patterns or long 
data patterns (for example, PRBS31) that do not repeat through the scope memory. If Arbitrary is 
selected, set the ISI filters.

• ISI Filter Lead — When using Arbitrary mode for the Jitter Pattern Length, set the Leading ISI filter 
coefficient. To help select the correct ISI filter, see Application Note 1574: Choosing the ISI Filter 
Size for EZJIT Plus Arbitrary Data Jitter Analysis (at www.keysight.com, literature part number 
5989-4974EN).

• ISI Filter Lag — When using Arbitrary mode for the Jitter Pattern Length, set the Lagging ISI filter 
coefficient. Again, to help select the correct ISI filter, see Application Note 1574: Choosing the ISI 
Filter Size for EZJIT Plus Arbitrary Data Jitter Analysis.

http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
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